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About the WhatsUp Gold Distributed Edition 

The WhatsUp Gold Distributed Edition extends the capabilities of a single WhatsUp product 
to let you monitor multiple remote networks (sites) from a central location. This solution 
includes a WhatsUp Gold Central installation and a WhatsUp Gold Remote installation.  

The WhatsUp Central Site installation coordinates data feeds from multiple WhatsUp Remote 
Site installations. The network data can then be viewed in reports that you select and 
customize on the Central Site. The Central and Remote installations, together, provide high 
visibility to the networks from one central location.  

   
 

About the Distributed Edition reporting capabilities 
The WhatsUp Gold Distributed Edition lets you set up and view reports associated with each 
monitored network. You set up centralized reports on the Central Site to gather key data 
from the Remote Sites. With the monitoring and reporting capabilities you can be confident 
that you will stay informed about the overall network health. In fact, if you loose the 
connection between the Central and Remote Sites, the information from the last network 
scan is still available on the Central Site. Each Remote Site continues to run an independent, 
full-featured version of WhatsUp, so it continues to gather network data, regardless of the 
connection status between the Remote and Central Sites.  
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All data communicated between the Central and Remote Sites is transferred over Secure 
Socket Layer (SSL) protocol to ensure that data is secure and confidential. The SSL 
communications between sites occur seamlessly, with no extra user setup required. 
 

System requirements 

Minimum software requirements 
� Windows XP Professional SP2 or Windows 2003 Server SP1 

� Microsoft Internet Explorer 6.0 SP1 (or later) or Firefox 1.5 (or later) 

� Microsoft Windows Scripting Host v5.6 or later.  

Windows Scripting Host is installed with the Windows operating system. To verify your 
version, run cscript.exe at a command prompt. 

If you need to update Windows Scripting Host, go to the Microsoft Windows Scripting 
Host site. 

� Internet connectivity for activation, connecting Central and Remote Sites, and running 
the web interface. 

Minimum hardware requirements 
� Intel Pentium-compatible 2 Ghz or faster  

� 1 GB memory (RAM) (2 GB RAM recommended) 

� 256 MB of drive space (up to 3 GB additional for MSDE database and 7200 RPM drive 
recommended) 

 Note: This is the requirement for installation. You will need more disk space for the database. 
An MSDE database can grow up to the 2 GB disk space limit. 

� CD-ROM drive 

� Network Interface Card (NIC) 

� Modem and phone line (for pager, SMS, or beeper actions; modem pooling is not 
supported) 

� SAPI v5.1 and supporting sound card for Text to Speech Actions; SAPI v5.1 can be 
downloaded from the Microsoft Speech site 
(http://www.microsoft.com/speech/download/sdk51/) 

MSDE 2000 requirements 
� MSDE has a 2 GB data limit; however, up to an additional 1 GB may be used for temporary 

storage. Make sure you select a large enough capacity disk drive for data storage. 

� File and Print Sharing must be enabled to run MSDE 2000. 
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To verify that file and print sharing are enabled: 
1 Select Start > Control Panel. 
2 On the Control Panel, select Network Connections. 
3 From the menu bar, select Advanced > Advanced Settings. 
4 On the Adaptors and Bindings tab, make sure the File and Print Sharing for Microsoft 

Networks option is selected. 
 

Installing Central and Remote Sites 

Installation overview 
The Ipswitch WhatsUp Gold Distributed Edition is comprised of the: 

� WhatsUp Gold Central Site component installed on a network computer to collect data 
from and monitor all of the Remote Sites. 

� WhatsUp Gold Remote Site component installed on a network computer at each 
remote location. Each remote site computer monitors the remote site network and 
reports the network status back to the Central Site. 

� Ipswitch Dashboard Screen Manager application automatically installed with the 
WhatsUp Gold Central Site. After the Central and Remote Sites are set up, you can 
configure this application to cycle through a series of selected WhatsUp Gold web 
interface pages and other Web pages that you want to view on a regular basis. The 
Dashboard is ideal to set up across multiple monitors to view multiple networks or 
Remote Sites, increasing visibility to the information that is most important to you. For 
more information, see Step 5: Using the Ipswitch Dashboard Screen Manager application 
(page 24). 

There are two installation programs for the Distributed Edition, one for the WhatsUp Gold 
Central Site and a second for the WhatsUp Gold Remote Site. The installation programs step 
you through the process of installing each part of the application.  

Following are the overview steps required to install the Distributed Edition: 

1 Install the Central Site application. For more information, see Step 1: Installing the 
WhatsUp Gold Central Site (page 6). 

� (Recommended) Select whether to enable the WhatsUp Web server and select the 
Web server port. 

� Create a User Name and Password that the Remote Sites will use when connecting to 
the Central Site. 

� Configure the TCP port that the Remote Sites will use to connect to the Central Site. 
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2 Make sure the firewall ports are specified and open for the inbound connections (from 
the Remote Sites on Port 9394 TCP). For more information see, Step 2: Configuring the 
firewall for Central and Remote Site connections (page 8). 

 
3 Install the Remote Site application at the remote locations. For more information, see 

Step 3: Installing the WhatsUp Gold Remote Site (page 9). 

� Select whether to enable the WhatsUp Web server and select the Web server port. 

� Set up the Central Site IP Address and TCP Port that the Remote Site(s) will use to 
connect to the Central Site. 

� Set the User Name and Password that the Remote Site(s) will use to gain access the 
Central Site. 

� Set up the Display Name for the Remote Site. 

� (Recommended) Enter the HTTP address that the Central Site will use to access this 
Remote Site's Web interface.  

� Run the network discovery to identify devices on the network and set up Active and 
Passive Monitors. 

 
4 Create Workspace Reports on the Central Site installation for each of the Remote Sites. 

For more information see, Step 4: Using Reports for WhatsUp Gold Distributed Edition 
(page 11). 

5 (Optional) Set up the Dashboard application on the Central Site. For more information, 
see Step 5: Using the Ipswitch Dashboard Screen Manager application (page 24). 
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After the above steps are complete, the application is ready to monitor, and be further 
customized and expanded as required. Data will be communicated from the Remote Sites to 
the Central Site. The network data is rolled-up in the workspace reports and full reports that 
you set up. For more information, see Step 4: Using Reports for WhatsUp Gold Distributed 
Edition (page 11). If you enabled access to the Remote Sites, you can drill-down from the 
Central Site reports to detailed historical data on the related Remote Site. 
 

Step 1: Installing the WhatsUp Gold Central Site 

The WhatsUp Gold Central Site serves as the monitoring system for important network 
activity data gathered by the Remote Sites. After the Remote and Central Sites are set up and 
reports are configured on the Central Site, the network status information from each Remote 
Site is communicated to the Central Site.  

Following is the information that is configured during the Central Site installation: 

� MSDE 2000 is installed on the Central Site computer. 

� Select whether to enable the WhatsUp Web server and select the Web server port. 

� Configure the TCP port that the Remote Sites will use to connect to the Central Site. 

� Create a User Name and Password that the Remote Sites will use to gain access the 
Central Site. 

� (Optional) Run the network discovery to identify devices on the network and set up 
Active and Passive Monitors. 

To install the WhatsUp Gold Central Site: 

The installation program is similar whether you are installing for the first time or upgrading 
from a previous WhatsUp installation. Steps that apply only to a first-time installation, or only 
to an upgrade, will be identified as such. 

To install or upgrade the Distributed Edition: 
1 Log in to an Administrator account on the computer on which you want to install the 

Central Site. 
2 Start the installation program: 

� If you purchased a WhatsUp Gold CD-ROM, insert the Central Site CD-ROM into the 
appropriate drive. If it does not run automatically, click Start, select Run, then enter 
the CD path followed by AutoRun.exe For example: D:\AutoRun.exe 

� If you downloaded WhatsUp Gold from the Ipswitch Web site 
(http://www.ipswitch.com), run the downloaded Central Site installation application. 

3 Read the Welcome screen.  

We recommend that you temporarily disable any antivirus software. You can also access 
the Release Notes and this guide. 

Click Next to continue. The License Agreement dialog opens. 

4 Read the license agreement. Select the appropriate option, then click Next. 
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5 (For new install only) Select the default install directories for MSDE 2000, then click 
Next. 

 Note: If you want to customize your database setup, you need to first complete the 
installation, then manually configure your database as described in Alternative Database 
Setups in the application Help. 

The application and data files will be installed in default directories. If you want to change 
the locations, click the browse buttons to find and select a different directory. 

 Important: Make sure that you have a large capacity drive selected for data storage. You will 
need up to 2 GB of free disk space for the MSDE 2000 database. 

6 (For new install only) Select the installation directory for the WhatsUp application files.  

The default path is C:\Program Files\Ipswitch\WhatsUp. We recommend that you 
use the default path. Some users prefer to put application files on a partition separate 
from the operating system, which is usually installed on the C: drive, to isolate the 
application from an operating system crash. 

7 (For upgrade installation only) Choose whether to backup your current WhatsUp 
database. We strongly suggest that you do this! 

8 (For upgrade installation only) Choose how to handle existing Web and Report files.  

If you have previously installed a version of WhatsUp, you may already have Web and 
Report files stored in your installation directory. You can choose to either delete them or 
back them up during the install. We recommend backing up files to preserve any 
customizations you may have done to the .asp files. 

9 (For new install only) Choose whether to enable the Web server during install and enter 
a port for this installation, then click Next. 

 Important: A Web server is required to view WhatsUp reports. If you do not enable a Web 
server during the installation, you need to enable the WhatsUp Web server or IIS Web server 
in order to view WhatsUp reports. 

 Note: This dialog will not be displayed during an upgrade if you have already enabled the 
WhatsUp Web server in a previous version of WhatsUp. 

10 Enter the TCP port that the Remote Sites will use to connect to the Central Site (default 
port is 9394). 

11 Enter a User Name and Password that the Remote Sites will use to access this Central 
Site, then click Next. The Ready to Install the Program dialog opens. 

 Note: Make note of this information. You will need the TCP port and User Name and 
Password information for each Remote Site installation. 

12 Click Install to install the WhatsUp Gold application files. The installation program gives 
you the option to click Back and change options or click Cancel prior to completing the 
installation. 
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13 Select whether you want to view the release notes and/or start the program, then click 
Finish. 

If you choose to launch now, the next screen asks you to activate the application. For 
more information, see Activating the WhatsUp Application in the application Help. 

After the activation screen, you are introduced to the Discover Devices wizard, which lets you 
set options on how to discover your local network. If you want to postpone these steps, click 
Cancel. You can manually start the local Discover Devices wizard in the WhatsUp console 
application at a later time. Start the console application, then click File > Discover Devices. 
 

Changing the Central Site  configuration settings 
The WhatsUp Gold Central Site installation program steps you through the configuration 
options for the Central Site. You can also update the configuration settings in the WhatsUp 
Console after installation. 

To update the Central Site configuration: 

� From the WhatsUp console, click Configure > Program Options, then click Central Site 
Configuration. For more information about the configuration settings, see the 
application Help. 

 

Step 2: Configuring the firewall for Remote Site 
connections 

Accessing the Central Site 
The WhatsUp Gold Distributed Edition is designed to simplify firewall connections. 
Communications are outbound from each Remote Site back to the Central Site, so only one 
configuration is required for all Remote Sites to communicate back to the Central Site. 

After you have set up the WhatsUp Gold Central Site, you need to determine what is required 
for the Remote Sites to connect across WANs, firewalls, routers, and other network security 
measures to communicate back to the Central Site. This information will be required as you 
install and configure each WhatsUp Gold Remote Site.  

If you are not responsible for these network security configurations, contact the appropriate 
network administrator to help you identify the requirements to allow the connections in to 
the Central Site. 

Accessing Remote Sites 
Additionally, it is not required, but you can also configure the Remote Sites to be accessible 
via their Web interfaces. By doing so, users can drill-down from the Central Site to specific 
reports and data on a specific Remote Site. You can control access from the Central Site to the 
Remote Site by providing varying levels of user privileges to data on each Remote Site. For 
more information, see Configuring user accounts (page 26) in the application Help. 
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Step 3: Installing the WhatsUp Gold Remote Site 

The WhatsUp Gold Remote Site monitors devices and network activity for each remote 
network site. After the Remote and Central Sites are set up and reports are configured on the 
Central Site, the network status information from each Remote Site is communicated to the 
Central Site. 

Following is the information that is configured during the Remote Site installation: 

� MSDE 2000 is installed on the Remote Site computer. 

� Select whether to enable the WhatsUp Web server and select the Web server port. 

� Set up the Central Site IP Address and TCP Port that the Remote Site(s) will use to connect 
to the Central Site. 

� Set the User Name and Password that the Remote Site(s) will use to gain access the 
Central Site. 

� Set up the Display Name for the Remote Site. 

� (Recommended) Enter the HTTP address that the Central Site's browser will use to access 
this Remote Site's Web interface. 

� Run the network discovery to identify devices on the network and set up Active and 
Passive Monitors. 

To install the WhatsUp Gold Remote Site: 

The installation program is similar whether you are installing for the first time or upgrading 
from a previous WhatsUp installation. Steps that apply only to a first-time installation, or only 
to an upgrade, will be identified as such. 

To install or upgrade the Distributed Edition: 
1 Log in to an Administrator account on the computer on which you want to install the 

Remote Site.  
2 Start the installation program: 

� If you purchased a WhatsUp Gold CD-ROM, insert the Remote Site CD-ROM into the 
appropriate drive. If it does not run automatically, click Start, select Run, then enter 
the CD path followed by AutoRun.exe For example: D:\AutoRun.exe 

� If you downloaded WhatsUp Gold from the Ipswitch Web site 
(http://www.ipswitch.com), run the downloaded Remote Site installation application. 

3 Read the Welcome screen.  

We recommend that you temporarily disable any antivirus software. You can also access 
the Release Notes and this guide. 

Click Next to continue. The License Agreement dialog opens. 

4 Read the license agreement. Select the appropriate option, then click Next. 
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5 (For new install only) Select the default install directories for MSDE 2000, then click 
Next. 

 Note: If you want to customize your database setup, you need to first complete the 
installation, then manually configure your database as described in Alternative Database 
Setups in the application Help. 

The application and data files will be installed in default directories. If you want to change 
the locations, click the browse buttons to find and select a different directory. 

 Important: Make sure that you have a large capacity drive selected for data storage. You will 
need up to 2 GB of free disk space for the MSDE 2000 database. 

6 (For new install only) Select the installation directory for the WhatsUp application files.  

The default path is C:\Program Files\Ipswitch\WhatsUp. We recommend that you 
use the default path. Some users prefer to put application files on a partition separate 
from the operating system, which is usually installed on the C: drive, to isolate the 
application from an operating system crash. 

7 (For upgrade installation only) Choose whether to backup your current WhatsUp 
database. We strongly suggest that you do this! 

8 (For upgrade installation only) Choose how to handle existing Web and Report files.  

If you have previously installed a version of WhatsUp, you may already have Web and 
Report files stored in your installation directory. You can choose to either delete them or 
back them up during the install. We recommend backing up files to preserve any 
customizations you may have done to the .asp files. 

9 (For new install only) Choose whether to enable the Web server during install and enter 
a port for this installation, then click Next.  

 Important: A Web server is required to view WhatsUp reports. If you do not enable a Web 
server during the installation, you need to enable the WhatsUp Web server or IIS Web server 
in order to view WhatsUp reports. 

 Note: This dialog will not be displayed during an upgrade if you have already enabled the 
WhatsUp Web server in a previous version of WhatsUp. 

10 Enter the Central Site's Address <Central_Site_ip> (enter only the IP address without 
http://) and the TCP Port that the Central Site will use to listen for a connection from the 
Central Site (default port is 9394). After you have entered this information, you can click 
Test to test the connection to the Central Site.  

11 Enter the User Name and Password that the Remote Site(s) will use to access this 
Central Site, then click Next. The Ready to Install the Program dialog opens. 

 Note: This is the User Name and Password that you set in the Central Site installation 
program. 
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12 Enter the Remote Site Display Name. This is the Remote Site name that the Central Site 
will use to identify this Remote Site (for example, Atlanta Office). The name will be 
particularly helpful to identify reports associated with each Remote Site. The default 
name is the computer name. Change it to better describe this Remote Site. 

13 Enter the HTTP Address (recommended, but not required). This is the address that the 
Central Site's browser will use to access this Remote Site. This address allows users to 
click links in the Central Site's Web interface to open browser connections directly to the 
Remote Site's Web interface (if the user has access permissions). Example: 
http://<Remote_Site_ip>:<Web server port> or http://192.168.200.123:8080. Click 
Next.  

 Note: This IP address should be accessible in order to enable drill-downs into this Remote 
Site installation from the Central Site. If inbound Web connections are not possible, only 
status information will be available at the Central Site. 

14 Click Install to install the WhatsUp Gold application files. The installation program gives 
you the option to click Back and change options or click Cancel prior to completing the 
installation. 

15 Select whether you want to view the release notes and/or start the program, then click 
Finish. 

If you choose to launch now, the next screen asks you to activate the application. For 
more information, see Activating the WhatsUp Application in the application Help. 

After the activation screen, you are introduced to the Discover Devices wizard, which lets you 
set options on how to discover your local network. Use this wizard if you plan to monitor the 
Central Site. If you only plan to use the Central Site to monitor Remote Sites, then you can 
click Cancel.  If you want to postpone these steps, click Cancel. You can manually start the 
Discover Devices wizard in the WhatsUp console application at a later time. Start the console 
application, then click File > Discover Devices. 
 

Changing the Remote Site configuration settings 
The WhatsUp Gold Remote Site installation program steps you through the configuration 
options for the Remote Sites. You can also update the configuration settings in the WhatsUp 
Console. 

To update the Remote Site configuration: 

� From the WhatsUp console, click Configure > Program Options, then click Remote Site 
Configuration. For more information about the configuration settings, see the 
application Help. 
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Step 4: Using Reports for WhatsUp Gold  
Distributed Edition 

After the Central and Remote Site installations are complete and communicating with each 
other, you can determine the Remote Site reports to setup so you can view network health 
information for each site. 

There are a number of new reports available for the WhatsUp Gold Distributed Edition. The 
two types of reports are: 

� Workspace Reports 

� Full Reports 
 

Workspace Reports: learning about the Central/Remote Workspace 
Reports 

The WhatsUp Home workspace is the first screen you see after logging in to the WhatsUp 
Gold web interface. This is your personal, customizable Home portal, or workspace. 

 

The WhatsUp Gold Remote/Central workspace reports are similar to the workspace reports 
you may have used in other versions of WhatsUp Gold. The primary difference is the 
Remote/Central workspace reports let you set up workspace reports that watch Remote Site 
network status from your WhatsUp Gold Central Site. For more information, see Learning 
about workspace reports in the Help. 

Workspaces are designed to be user-specific, and are configurable to include workspace 
reports specific to users' needs. Workspaces contain multiple views that let you organize 
various workspace reports by the type of information they display. When you begin 
customizing your workspace views, you should consider the types of information you need to 
view most often, the remote sites and devices in which you need to pay closest attention, and 
what level of detail you want to monitor through a particular workspace view. 
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There are several Central/Remote workspace reports included in a Remote Sites workspace 
view for the WhatsUp Gold Distributed Edition. They are available if you have completed a 
new installation of WhatsUp Gold application. If you are upgrading from a previous version of 
WhatsUp Gold, the Remote Sites reports are not added to the workspace view for existing 
users; however, you can create a new Workspace View and add the default Central/Remote 
workspace reports (see page 15) to it. 

Following are the default Central/Remote workspace reports included in the Remote Sites 
workspace view: 

Remote/Central Reports Description 

Remote Site List Lists all configured Remote Sites. The report contains: 

Display Name 

Local device 

Last connect time 

Last refresh time 

Device Status (Remote) Provides a status summary of all monitored devices on a selected 
Remote Site. The report contains: 

Display name 

Devices up 

Devices down 

In maintenance 

Last refresh time 

Monitor Status (Remote) Provides a status summary of all monitors configured for the monitored 
devices on a Remote Site. The report contains: 

Display name 

Monitors up 

Monitors down 

Last refresh time 

Remote Site Overview Displays an information overview for a selected Remote Site. The report 
contains: 

Http address 

Last connect time 

Last refresh time 

# of devices 

# of monitors 

# of queries 

Display name 

Device type 

Host name 

Address 
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Remote/Central Reports Description 

Summary Counts (Remote) Provides a summary for a Remote Site by the total number of: 

Monitored devices 

Up devices 

Down devices 

Devices with down Active Monitors 

Devices in Maintenance 

Active Monitors 

Down Active Monitors 

Up interfaces 

Down interfaces 

Actions fired in the last 4 hours 

Tail of Action Activity Log 
(Remote) 

Provides the tail (last 10 records) of the Action Log for a device group on 
a Remote Site. The report contains: 

Date 

Source 

Action Name 

Trigger 

Tail of Remote Site Log Provides the tail (last 10 records) of the Remote Site Log. The report 
contains: 

Date 

Type 

Message 

Remote Site 

Active Monitor Status 
(Remote) 

Lists all Active Monitors assigned to devices on the selected Remote Site 

Threshold - Ping by 
Response Time Over 1 ms 
(Remote) 

Displays ping response times by threshold for devices in a specific device 
group on a Remote Site. The report contains: 

Remote Site 

Last snapshot 

Device 

Interface 

Max (ms) 

Avg (ms) 
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Adding Remote/Central workspace reports to your Home Workspace 
You can add new Remote/Central workspace reports, including Top 10 reports, to the home 
workspace to customize workspace reports to best suit your needs. In the Workspace toolbar, 
click Add Content. 

 

Use the Add Content To View dialog to add one or multiple Remote/Central workspace 
reports to a workspace. 

 

 Note: The Tail of Remote Site Log is the only workspace report only available from the 
Remote Site. 

To add a workspace report: 
1 Click the + button next to a report category folder, then click a report option box for 

each report you want to add to your workspace. A preview image for each workspace 
report is displayed at the bottom of the dialog. 

 Tip: The Central/Remote Reports shortcut icons indicate that the report data 
originates from a Remote Site. 
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2 Click OK to save changes. The Home Workspace opens with the new workspace report 
added to the page. Also, notice the gray server icons when you first add a Remote Site 
workspace report. This indicates that you need to select a remote site for the workspace 
report.  

 
3 In the new workspace report, click Menu > Configure. 

 
The Configure Remote Report dialog opens. 

4 Select the Remote Site you want to add to the Home Workspace, select other options 
available in the dialog (the options vary depending on the workspace report you 
selected), then click OK. The new workspace report displays in the Home Workspace. 

(Additional options available only for the Remote Site Overview workspace report) 
5 After you select a Remote Site, the Local device box displays in the dialog. Click the 

Browse (...) button next to the Local device box. The Edit Remote Site dialog opens. 

 
6 The Accept remote site connection option is selected by default. It allows users, with 

rights, the ability to select or deselect (from the Central Site) the option to accept 
connections from Remote Sites.  
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The primary reason to clear the check box option is if you need to disable the Central Site 
from accepting connections from this Remote Site. For example, this option could be 
helpful if one of the Remote Sites connected to the Central Site has an unusual amount of 
activity and is using too much bandwidth between sites. You can use this option to 
disable the Central Site from accepting connections from this Remote Site until you 
resolve the problem. 

Use the Local device checkbox to associate a device with the Remote Site. This device is 
often the computer that is running the WhatsUp software on a Remote Site. Associating a 
local device allows you to view the device status from the Remote Site, keeping you 
informed about the connection status with the Remote Site. It also provides easy access 
to the Network Tools for the local device you selected. Click the Browse (...) button, next 
to the Local device box, for a list of devices on the Remote Site. The Select a Device dialog 
opens. 

7 Select a device that you want to associate with the Remote Site workspace report. This 
device will display in the workspace report. Click OK, then click OK to close the Edit 
Remote Site dialog. The Configure Remote Report dialog opens. 

8 Click OK to save changes. The Home Workspace opens displaying the green collecting 
data icons. The icons indicate that the Remote Site has connected and is collecting data 
for the Central Site. 

 

The Remote Site will update shortly or you can click the icons to force a refresh of the 
Remote Site data. 

 

Using the Remote/Central workspace reports 
While the Remote Site workspace reports work very much like workspace reports in WhatsUp 
Gold Standard and Premium Editions, there are a few items to note about the reports that 
help you identify them as Remote/Central workspace reports rather than local network 
workspace reports. 

� The Remote Site header includes a network icon next to the Remote Site name to 
differentiate the Remote Sites from the local network devices (see 1) 

� When you mouse over a Remote Site name, address, group name, status, etc., a shortcut 
icon  displays to indicate that you can click to drill through the information on the 
Remote Site (see 2). When you click the shortcut icon , a new web browser window 
opens for the selected Remote Site. 

 Important: Make sure that you select the option Access Remote Reports for each user that 
you want to provide access to the Remote Site reports. Also, make sure that you select the 
option Configure Remote Sites if you want a user to be able to access and change options 
in the Configure Remote Sites dialog (Go > Configure > Configure Remote Sites). For more 
information, see Configuring user accounts (see page 26). 
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� The Last snapshot information indicates the last date and time the Remote Site data was 
sent to the Central Site (see 3). 

� The date and time information turns blue if it has been longer than 5 minutes since 
the remote site last updated. 

� The date and time information turns red if it has been longer than 10 minutes since 
the remote site last updated. 

 
 

Moving and removing Remote/Central workspace reports 
WhatsUp Gold supports drag-and-drop within the web interface. You can move a workspace 
report from one column of a workspace view to another, or position a workspace report 
above or below another workspace report, by selecting it and dragging it to another area of 
the workspace view. These location changes are saved: workspace reports will appear in the 
location to which you moved them after logging out from the web interface or after moving 
between workspace views. 
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To move a workspace report: 
1 Select the title bar of the report you want to move, then drag it to the desired location. 

A red box highlights the area that the report will be placed when the mouse button is 
released. 

2 Release the mouse button to place the report in the new page location. If you want to 
cancel the move, while the report is selected, press the Esc button. 

To remove a report: 

In the Web interface, go to the menu for a specific workspace report and click Close.  

 

Keep in mind, when you remove a report, any customizations you have made to it are lost. 
 

Managing Workspace Views 
WhatsUp Gold comes with a few preconfigured workspace "views," including one for Default 
Remote Sites. You can create more of your own Workspace Views to use along with the 
preconfigured views. You can create as many as you feel necessary to organize your system 
for efficient reporting. You can also edit, copy, copy to (another user), and delete these views 
as needed. 

From the Workspace View list, select Manage Workspace Views. 

 

In the Manage Workspace Views dialog, you can create new workspace views, and edit, copy, 
or delete an existing workspace view. 

 
� Click New to configure a new workspace. 

� Select an existing workspace view and click Edit to change the current configuration of a 
workspace. 
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� Double-click an existing workspace to change its configuration. 

� Select a workspace view, then click Copy to make a copy of that workspace and add it to 
the list. 

� Select a workspace view, then click Copy to to copy an existing workspace from here to 
another user's list of workspaces. 

� Select a workspace monitor view, then click Delete to remove it from the list. 

To create a new workspace view: 
1 From the Manage Workspace Views dialog, select New. The New Workspace View dialog 

opens. 

 
2 Enter the appropriate information in the following fields: 

� View name. Enter a name for the workspace view. 

� View type. Choose a type for the workspace view from the drop-down menu. 

� Column count. Enter a value for the number of columns you wish to have in the new 
workspace view. Keep in mind, the more columns you include, the smaller the data 
displayed inside a workspace.  

� Enter a value in pixels for each of the workspace columns. 

3 Click OK to save changes. 

To edit a workspace view: 
1 From the Manage Workspace Views dialog, select Edit. The Edit Workspace View dialog 

opens. 
2 Enter the appropriate information in the following fields: 

� Workspace name. The workspace title as it appears in the Workspace Library. 

� Workspace type. The workspace type as it appears in the Workspace Library (Home 
or Device).  

 Note: Workspace view types cannot be changed after a view is created. For example, a 
Home workspace type cannot be changed later to a Device Status workspace type. 

� Column count. The number of columns in the workspace. 

� Column width. The width of each column in the workspace in pixels. 

3 Click OK to save changes. 
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To copy an existing workspace view: 
1 From the Manage Workspace Views dialog, select Copy. The Edit Workspace View 

dialog opens. 

 
2 Enter the appropriate information in the following fields: 

� Workspace name. The workspace title as it appears in the Workspace Library. 

� Column count. The number of columns in the workspace. 

� Column width. The width of each column in the workspace in pixels. 

3 Click OK to save changes. 

To copy a workspace view to another WhatsUp Gold user: 
1 From the From the Manage Workspace Views dialog, select Copy to. The Edit 

Workspace View dialog opens. 

 
2 Enter the appropriate information into the following fields: 

� Copy to user. Select a user account from the drop-down menu in which to copy the 
workspace view. 

� View name. The name of the workspace view as it will appear in the Workspace 
Library. 

3 Click OK to save. 

To delete a workspace view: 
1 From the From the Manage Workspace Views dialog, click Delete. 
2 Click OK on the dialog that follows. 
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Full Reports: learning about the Central/Remote Full Reports 
The WhatsUp Gold Distributed Edition includes two full reports for Remote Sites, located on 
the Reports tab in the System category:  

� Remote Site Log 

� Remote Site Status 

 

Advantages of full Reports 
� Larger than the workspace reports, full reports give you a larger data view, which can be 

useful in pin-pointing the time something happened, or viewing multiple graphed items. 
Many workspace reports link to full reports, so that you can view this larger data view to 
troubleshoot. 

� The date range on full reports can be zoomed in on, or zoomed out on, so that you can 
get a smaller or larger picture of what's going on with a particular aspect of the network.  

� A list in the upper-right corner of a full report screen allows you to navigate to other 
reports in the same category. When you use this list to navigate to another report, the 
date range selected in the report you are navigating away from is transferred to any 
report you view subsequently. 

Much of the data in full reports can be exported to Microsoft Excel or to a formatted text file. 
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Using the Remote Site full reports 
The Remote Site Log provides a record of error messages generated by the Remote Site 
connection attempts.  

 

Click a Remote Site name to open an instance of the Remote Site WhatsUp Gold Web 
interface. For more information about the Remote Site Log, see the application Help. 

The Remote Site Status report provides overview information about the state of the devices 
and active monitors on the Remote Sites.  

 

Click a number in one of the columns to drill-down to more detailed information about up 
and down devices and monitors and devices in maintenance. 

 Note: The Remote Site Status report is only available from the Central Site. 
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Step 5: Using the Ipswitch Dashboard Screen 
Manager application 

After you have the Central and Remote Sites working, have customized your workspace 
reports and started viewing the Remote Site full reports, you can take advantage of the 
Ipswitch Dashboard Screen Manager capabilities. The Dashboard is installed on the Central 
Site by default. However, if you prefer to install the Dashboard on a system other than the 
Central site, you can locate the .exe installation file at ..\Program 
Files\Ipswitch\WhatsUp\Dashboard.exe. 

The Dashboard Screen Manager is a stand-alone application designed to display a series of 
Web pages, or a "playlist," on one or multiple monitors. The Dashboard was created as a 
complement to the Ipswitch network monitoring application, WhatsUp Gold, and as an aid to 
keeping your network visible. The Dashboard application is included in the WhatsUp Gold 
Central and Remote Site installations. 

The Dashboard can run on a display console and cycle through various pages from the 
WhatsUp Gold web interface. Network administrators then have important and pertinent 
network information on display at all times, cycling and changing on its own without the 
need of constant configuration. It also provides the capability to view multiple networks that 
you are monitoring simultaneously. 

Though the Dashboard Screen Manager was created to work along-side WhatsUp Gold, it can 
display virtually any Web page. For example, an Internet business providing service to a small 
town in the desert glances at one screen on the Dashboard and sees that the connectivity to 
the town is down. By displaying the weather for this town on another screen at the same 
time, the network administrator is able to see that the extreme temperatures of the day have 
likely caused problems for the cable transmitters. 

 Note: If you want to display a password protected page for another Web application, you 
must supply a valid username and password for the page. For more information, see the 
Dashboard application Help. 

For more information about installing and using the Dashboard Screen Manager, see Using 
the Ipswitch Dashboard Screen Manager, a document located on the Ipswitch Network 
Monitoring Web site (http://www.ipswitch.com/products/network-management.asp). 

To further enhance your network activity visibility, you may also want to set up a multi-
monitor network display, for more information see Setting up a WhatsUp Multi-Monitor 
Network Display, a document located on the Ipswitch Network Monitoring Web site 
(http://www.ipswitch.com/products/network-management.asp). 
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Installing the Dashboard compatibility patch 
A Dashboard patch has been created for users who plan to use the Dashboard with WhatsUp 
Gold v11, v11.0.1, or v11.0.2 installations on other systems. You need to install the WhatsUp 
Gold v11 Dashboard Compatibility Patch manually on each of the systems. This patch is not 
required if you have installed WhatsUp Gold v11.0.3 Editions. 

The Dashboard installation directory, located at ..\Program 
Files\Ipswitch\Dashboard\WUG_v11_Patch, provides a patch file to update remote 
WhatsUp Gold v11 installations to take full advantage of the Dashboard Screen Manager. 
Apply this patch to each of the WhatsUp Gold v11 remote installations. 

If your system configuration matches either of the following two scenarios, you need to 
install this patch: 

1 If you are running the Dashboard on a system that does not have WhatsUp Gold 
installed, but you are planning on displaying WhatsUp Gold from another v11, v11.0.1 or 
v11.0.2 system, you must install the patch on the WhatsUp Gold system. 

2 If the system on which you are running the Dashboard has WhatsUp Gold installed on it, 
the patch is automatically installed. However, if you are planning on displaying WhatsUp 
Gold from systems other than the system on which you have installed the Dashboard, 
you must install the patch on every other WhatsUp Gold system that you plan to display 
via the Dashboard. 
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Configuring user accounts 

User accounts granted the Manage User right can create new user accounts on WhatsUp 
Gold. New user accounts are created and edited on the WhatsUp Gold web interface via the 
Manage Users dialog. You can access the Manage Users dialog at Go > Configure > Manage 
Users. Beginning in v11, the Enable Group Access rights function was moved to the 
Manage Users dialog. For more information, see About Group Access Rights in the application 
Help. 

 

To create a new or edit a WhatsUp Gold user account: 
1 On the WhatsUp Gold web interface, open the Manage Users dialog at Go > Configure 

> Manage Users.  
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2 On the Manage Users dialog, click New. The Add User dialog appears. 

- Or - 

On the Manage Users dialog, select a user account and then click Edit. The Edit User 
dialog appears. 

 
3 On the Add/Edit User dialog, enter the appropriate information in the following fields: 

� User Name. Enter the name of the user. 

� Authentication Type. Select the method of authenticating the user. 

� Internal. Use WhatsUp Gold's internal user database. 

� LDAP. Use an external LDAP database. 

� Language. Select the language to display for the user. 

� Internal Password. Enter the user's password (only if Authentication Type is set to 
Internal). 

� Confirm Password. Enter the user's password again. 

� Home Group. Select the device group that the user will see when they log into the 
WhatsUp Gold web interface. If they have the correct group access rights, they will be 
able to navigate out of this group. 

� User Rights. Select which options to give the user access to. 
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 Important: If you are using the WhatsUp Gold Distributed Edition, from the Central Site, 
make sure that you select the option Access Remote Reports for each user that you want to 
provide access to the Remote Site reports. Also, make sure that you select the option 
Configure Remote Sites if you want a user to be able to access and change options in the 
Configure Remote Sites dialog (Go > Configure > Configure Remote Sites). This dialog 
provides a list of all of the Remote Sites that have connected to the Central Site. You can 
view and edit two important settings in this dialog:  
 
Accept remote site connection. Allows users, with rights, the ability to select or deselect 
(from the Central Site) the option to accept connections from Remote Sites. This option is 
checked by default. The primary reason to uncheck the option is if you need to disable the 
Central Site from accepting any connections from this Remote Site. For example, this option 
could be helpful if one of the Remote Sites connected to the Central Site has an unusual 
amount of activity and is using too much bandwidth between sites. You can easily, 
temporarily, disable a single Central Site from accepting remote site connections until you 
determine what the problem is. 
 
Local device. Allows users, with rights, the ability to select a local device to associate the 
Remote Site with. Click the Browse (...) button to select a device. This device is often the 
computer that is running the WhatsUp software on a Remote Site. Associating a local device 
allows you to view the device status from the Remote Site, keeping you informed about the 
connection status with the Remote Site. It also provides easy access to the Network Tools for 
the local device you selected. 

� Check all rights. Select this option to select all the user rights listed. 

4 Click OK to save changes. 
5 If you have enabled Group Access Rights, you will be prompted if you would like to 

specify Group Access Rights for the new user account. Answer accordingly. 

 

To delete an existing user account: 
1 On the WhatsUp Gold web interface, open the Manage Users dialog at Go > Configure 

> Manage Users.  
2 On the Manage Users dialog, select a user account and then click Delete. 
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Getting more information 

Now that you have your WhatsUp Gold Central and Remote installations up and running, you 
can learn more about using WhatsUp Gold. Following are information resources for WhatsUp 
Gold. This information may be periodically updated and available on the WhatsUp Gold 
support page (http://www.ipswitch.com/support/whatsup/index.asp). 

� Release Notes. The release notes, located in the Start > Programs > Ipswitch WhatsUp 
Gold >  Release Notes, provide an overview of changes, known issues, and bug fixes for 
the current release. The notes also contain instructions for installing, upgrading, and 
configuring  WhatsUp Gold. To view or download the release notes, go to the Ipswitch 
Web site (http://www.ipswitch.com/WUG1103relnotes). 

� Application Help for the console. Contains dialog assistance, general configuration 
information, and how-to's that explain how to use the features. The Table of Contents is 
organized by functional area, and can be accessed from the main menu or by clicking 
Help. 

� Application Help for the web interface. Contains dialog assistance, how-to's that 
explain how to use features, table of contents, index, and search. Click ? to access the 
Help. 

� Getting Started Guide. Provides an overview of WhatsUp Gold, information to help you 
get started using the application, the system requirements, and information about 
installing and upgrading. To view or download the Getting Started Guide, go to the 
Ipswitch Web site (http://www.ipswitch.com/WUG1103GSG). 

� User Guide. This guide describes how to use the application out-of-the-box. It is also 
useful if you want to read about the application before installing. To view or download 
the User Guide, select Help > WhatsUp Gold User Guide or go directly to the guide on 
the Ipswitch Web site (http://www.ipswitch.com/WUG1103Guide). 

� Translation Guide. This guide describes how to use the translation features to create a 
localized version of the WhatsUp Gold web interface. To view or download this guide, go 
to the Ipswitch Web site (http://www.ipswitch.com/WUG11Trans). 

� WhatsUp Gold Forum (http://forums.ipswitch.com/). Provides a resource for you to 
interact with other WhatsUp Gold users to share helpful information about the 
application. 

� The Ipswitch Knowledge Base (http://support.ipswitch.com/kb/). Search the Ipswitch 
Knowledge Base of technical support and customer service information. 
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